
Software Release Notes  

March 11, 2026 

OPS686 Graphtec Studio2 for Windows 

Version 1.11.50 Release date: March 11, 2026  

⚫ Function Added. 

1. Added a “Page Length” setting to the [Remote Panel Utility] (FC9000/CE8000/CE7000 
only). 

⚫ Fixed Problem. 

1. Fixed a where enabling the “Weed Border” in the “Weed” tab and then selecting either 
“By Color” or “By Layer” in the “Options” tab would set unsupported options for the 
“Weed Lines” conditions in Graphtec Studio 2. 

2. Fixed a problem where opening an AI file containing Registration Marks caused the 
positions of the Registration Marks and the Start Mark to shift. 

3. Fixed a problem where opening certain DXF files caused the text orientation and shape 
colors to be displayed incorrectly. 

4. Fixed problem where pressing the Pint button in the print screen of Graphtec Studio 2 
caused the application to crash. 

5. Fixed a problem where, when “Repeat Job” was specified and cutting was in progress, 
the cutting plotter resumed the repeat cutting even if the user stopped the cut operation 
on the main unit (CE8000/CE8000-40+ASF1 only). 

6. Fixed a problem where, even when “Use Document Origin” was specified in the 
“General” tab under “Origin”, the setting was invalidated and cut lines shifted to the 
lower-right when some cut lines were turned OFF in the “Option” tab using either “By 
Color” or “By Layer”. 

7. Fixed a problem where DXF layers were not being reflected. 

8. Fixed a problem where pressing the OK button on the message displayed when 
closing the Cut screen over a LAN connection cause the application to freeze and fail 
to close. 

9. Fixed a problem where, after selecting “By Color” or “By Layer” in the “Option” tab and 
then turning ON “Weed Vorder”, the weeding border (green line) was not displayed in 
the cut preview and was not cut during output. 

10. Fixed a problem where, after selecting “By Color” or “By Layer” in the “Option” tab and 
then turning ON “Weed Border”, reopening the “Option” tab caused the setting to revert 
to “ALL”. 

11. Fixed a problem where, when “Weed Border” was turned ON, shapes that had the 
check removed in the “Color/Layer” list were not hidden in the cut preview. 

12. Fixed a problem where, in the “Data Link Server Settings” screen, opening the right-
click menu displayed English text even when Japanese was selected. 

13. Fixed a problem where, in the “ARMS” tab of the [Remote Panel Utility], the text for 



“Auto Search” and “Sensing Method” was displayed swapped. 

14. Fixed a problem where, when the cutting plotter was set to inch mode, the “2mm 
BELOW” option under  “INITIAL BLADE ANGLE POSITION” in the “Others” tab of the 
[Remote Panel Utility] was not displayed in inches. 

15. Fixed problem where, when multiple PCs were using a cutting plotter over a network, 
none of the PCs were able to send data. 

16. Fixed a problem where, in the “Data Link Server Settings” screen, deleting a 
“Destination Email Address” using the “-” button and then closing and reporting the 
stings screen caused the deleted email address to reappear. 

17. Fixed a problem where, in the “Data Link Server Settings” screen, a test send 
performed with incorrect email notification settings did not display a failure error 
message. 

 
 
Version 1.10.36 Release date: December 26, 2025  

⚫ Function Added. 

1. Added the WLAN setting function for CE8000 series and CE8000-ASF1-30. 

⚫ Fixed Problem. 

1. Fixed a problem where staring another queued job during cutting stopped the cutter 
from working afterward. 

2. Fixed a problem where Matrix Copy settings were not applied to [Job Size] in [General] 
tab, causing the carriage to move incorrectly. 

3. Fixed a problem where maximum values withing the media range could not be entered 
for Matrix Copy [X Copy] and [Y Copy]. 

4. Fixed a problem where enabling [Auto Weld] with certain data caused slow preview 
updates. 

5. Fixed a problem where cut lines did not appear in the preview of the Cutting View when 
opening certain DXF files. 

6. Fixed a problem where shapes colors were not reflected in the Design View when 
opening certain DXF files. 

 
 
Version 1.9.92 Release date: October 31, 2025  

⚫ Fixed problem 
1. Fixed a problem in which the cut screen would freeze when performing a cut with 

‘Repeat Job’. 
2. Fixed a problem in which a timeout error occurred after reading the barcode on the 

second page during continuous operation with CE8000-40+ASF1 connected via wired 
LAN. 

3. Fixed a problem in which opening the ‘Cutting View’ screen with certain ‘gstudio2’ file 
could cause the application to crash. 

4. Fixed a problem in which the cut screen could crash when outputting to certain data 
files and either PLT or XPF files. 



5. Fixed a problem in which setting ‘Number of Passes’ in the ‘Option’ tab now correctly 
repeats cut for each shape. 

6. Fixed a problem in which shapes drawn with a line width of 0.00pt were not printed 
even when ‘Print lines of selected shapes’ was turned ON. 

7. Fixed a problem in which part of the registration marks would be missing when printing 
or exporting to PDF, if shape with a white background overlapped the registration 
marks of the design screen. 

8. Fixed a problem in which the application could crash when launching Cutting Master 
5 and the ‘Cutting View’ screen simultaneously. 

9. Fixed a problem in which the cut screen failed to launch after changing the ‘Interface’ 
setting in the cutter edit screen. 

10. Fixed a problem in which changed cut settings were automatically saved even without 
performing ‘Save Cut Conditions’. 

11. Fixed a problem in which XPF files could not be selected in the save cut command 
when ‘Repeat Job’ was specified. 

12. Fixed a problem in which the email settings were hidden and difficult to view in the 
Data Link Server Settings screen. 

13. Fixed a problem in which selecting and moving all shapes in certain data caused 
spacing between shapes to shift. 

14. Fixed a problem in which inserting certain SVG files could not cause parts of shapes 
to be missing. 

⚫ Modification 
1. Modified the system to allow corner radius adjustment via numeric input. 
2. Modified the system to display a waring message when the cut screen is closed without 

pressing the output button. 

 
 
Version 1.8.86 Release date: August 20, 2025  

⚫ Fixed Bug 

1. Fixed a problem in which one side of the vertical split was not cut correctly 
when performing Tiling function on specific data. 

2. Fixed a problem in which shapes drawn with lines of thickness “0.0pt” were 
being printed. 

3. Fixed a problem in which shapes on hidden layers were being printed. 
4. Fixed a problem in which opening certain DXF files caused shapes to 

become distorted. 
 
Version 1.8.67 Release date: July 1, 2025  

⚫ Function Added 

1. Added Layers function. 

2. Added a function to save customized page size. 

 

⚫ Modification 

1. Extended the minimum value Length of Repeat CROSS CUT to 20mm in FC9000 (later 

than firmware version 2.00). 

2. Improved the operation speed of the Mail Merge function. 
 
⚫ Fixed Bug 

1. Fixed a problem in which a red frame appears when opening “Tiling” tab while registration 



marks are placed. 
2. Fixed a problem in which the letters entered in the “Data” field of the “Mail Marge Barcode 

Panel” were automatically capitalized. 
3. Fixed a problem in which the resolution of image was reduced when opening PDF files with 

“Import as Vector” option selected. 
4. Fixed a problem in which some text became distorted when opening DXF files. 
5. Fixed a problem in which the print window did not appear after closing Print Preview window 

using the X button. 
 

 
Version 1.7.66 Release date: March 10, 2025  

●Fixed Bug 

1. Added Mail Merge function. 

2. Fixed the problem that the cutting order was not output correctly. 

3. Deleted unnecessary Save buttons from [Cut Job List] in [Data Link Server]. 

4. Fixed the problem that the objects outside the frame were included in the design 

when using a PDF file. 

5. Fixed the problem that the large canvas pdf would reduce its document size to 

1/10th of its original size when opening it. 

6. Fixed the problem that the wrong XPF file would be output when 2 or more were 

entered to [Repeat Job] in the [General] tab of Cutting View. 

7. Fixed the problem that [Printer Margins] would not be automatically extracted when 

[Use Auto Sheet Feeder (ASF)] is selected and placed a Barcode. 

8. Fixed the problem that the design objects containing rounded corners would get 

corrupted when opening DXF files. 

9. Deleted products that are out of warranty from the installer. 

FC2250 / FC4500 / CE6000 

10. Fixed the problem that the file extension (.xml, .csv) which is unnecessary would 

be displayed when saving Edit Custom Line Style in Cutting View > Option > Line 

Type. 

11. Fixed the problem that the machine stops cutting in the middle of the data when 

using [Data Link Server]. 

12. Fixed the problem that the design window crashes when printing out the A0 size 

data. 

 
Version 1.6.15 Release date: December 24, 2024  

●Fixed Bug 

1. Fixed an issue that slowed down the startup of the cut screen when selecting a 

part of a large data set, even if “Selection Only” was set to ON in the “Option” tab. 

2. Fixed an issue that the cut screen crashes when outputting via USB connection 



when a large amount of data that does not contain registration marks is copied 

using matrix copying. 

3. Fixed an issue when saving XPF or PLT files, the file name on the save screen is 

blank. 

4. In CE8000-40+ASF1, the wording and size of the media size “A3 Plus” have been 

corrected. 

5. Fixed an issue when “X Direction”=”Horizontal” is specified in the Registration 

Marks setting, the cut screen preview cannot be rotated. 

6. Fixed an issue that after opening a “gstudio2” file in which registration marks 

were placed, the marks could not be placed correctly in the new document. 

7. When using a cut request file, if an error occurs in starting the cut screen skip, 

the cut screen is displayed. 

 
Version 1.6.6 Release date: December 2, 2024  

●Function Improved 

1. Correspondence for the CE8000-40+ASF1. 

 

●Fixed Bug 

1. Fixed an issue that the cutting screen crashed when “Repeat Job” was set to output. 

 
Version 1.5.43 Release date: October 28, 2024  

●Function Improved 

1.  Improved display of a bar indicating that data is being sent when a cut is executed. 

2.  The cut screen can be skipped when a cut request file is used. 

(Function for EPSON RIP software.) 

 

●Fixed Bug 

1.  Fixed an issue that the minimum value cannot be set for “X or Y Spacing” on the 

“Matrix Copy” tab, even if setting the color or layer that will not be cut to “OFF” in the 

“By Color” option. 

2.  Fixed an issue when a cutter is changed, “Media Size” is not updated to the maximum 

value of the changed cutter. 

3.  Fixed an issue that skipping a paused color ignores the next specified cut condition 

in the “By Color” option. 

4.  Fixed an issue when “Optimize Cutting Order” is “None”, the outer figure is cut first, 

even if “Sort Interior Contours First” is set to “ON”. 

5.  Fixed a problem with resizing when opening the data which has registration marks 



after using “Fit to Media”. 

6.  Fixed a problem that “0” entered by a numeric keypad in the IP address is not 

reflected correctly. 

7.  Fixed an issue when opening a PDF file containing registration marks exported from 

Graphtec Pro Studio, the file is not recognized as data containing registration marks. 

(Revised in V1.4.53 ⇒ Re-revised in V1.4.65) 

8.  Fixed an issue that the design screen is forced to close when using certain gstudio2 

files. 

9.  Fixed an issue that scanning starts from a mark at the wrong position in a matrix 

copy of a registration mark, resulting in a scanning error. 

 
Version 1.4.65 Release date: August 26, 2024  

●Fixed Bug 

 1.  Fixed a problem in which “Job Size” in the “General” tab did not reflect the setting 

even if “Selection Only” was specified in the “Options” tab of the cut screen. 

 2.  Fixed a problem where certain shapes created with the Flexi-Shape tool would miss 

a portion when cut.  

 3.  When using mask registration marks, the image of the mask is not reflected in the 

preview of the cut screen. 

 4.  Fixed a problem that prevented adding another cutter's tab from the cut screen while 

the [Data Link Server] was open. 

 5.  Fixed a problem that prevented firmware download updates via update notifications 

on 32-bit Windows. 

 

Version 1.4.53 Release date: July 10, 2024  

●Added 

1. Correspondence for the CE8000. 

 

●Modification 

1.  The waiting time required from the end of cutting to the start of cutting has been 

improved. 

2.  Improved the drop-down items so that they can be selected with the up/down keys 

on the keyboard. 

 

●Function added 

1.  Added first registration mark search option. 

2.  Added Prefeed option. 



3.  Added “Data Link Server” e-mail notification. 

4.  Added firmware update notification and download update functions. 

 

●Fixed Bug 

1.  In the [Replicate] panel - [Advanced Replicate] tab - [Position each Copy] - [Custom 

Position], the text errors in [X Offset] and [Y Offset] have been corrected. 

2.  When [Step Size] is changed on the cutter, the wrong paper size is displayed when 

[Poll Size] is executed on the cut screen. 

3.  Fixed a problem in which cross-cutting on the cut line occurred when the position in 

the feed direction (X direction) was changed in the [General] tab - [Position]. 

4.  Fixed a problem in which opening a PDF that contains registration marks exported 

from Graphtec Pro Studio is not recognized as data that contains registration marks. 

5.  Fixed a problem in which the "Connection test" and "OK" buttons could not be 

pressed when IP addresses were entered using the numeric keypad on the "Add Cutter" 

screen. 

6.  Fixed a problem in which another model could not be used even if the "Connect the 

cutter to output destination" was set to OFF.  

7.  Fixed a problem with fill-in when certain PDFs are opened. 

 

Version 1.3.137 Release date: April 15, 2024  

⚫ Modification 

1.  Added backup and restore functions for cutter settings.  

2.  Cut request files are now supported. (EPSON-RIP linkage) 

3.  Added an eyedropper tool to the Fill Color and Line Color screens. 

4.  Changed the layout of the [Help] tab of the [Remote Panel Utility] screen. 

5.  The UI of the one-point compensation option for four-point registration marks was 

improved.  

 

●  Fixed Bug 

1. Fixed an issue with switching fonts while typing with the text tool. 

2. Fixed an issue that when [Speed Priority] or [Restrict Media Movement] is specified in 

[Optimize Cutting Order], [Cut Segments From Ends to Center] will not work. 

3. Fixed an issue in which partial cuts were not made when [Speed Priority] or [Restrict 

Media Movement] is specified in [Optimize Cutting Order] and [Sort Interior Counters First] is 

specified. 



4. Fixed an issue that a part of the line of a shape touching the outer frame was cut off on 

the preview when using certain rounded corner data. 

 

Version 1.2.65 Release date: December 26, 2023  

⚫ Fixed Bug 

1. Fixed a problem in which a different value was set when a value other than "millimeter" 

was specified for "Unit of measurement" and a value was entered in the text area of 

[General] tab - [Job Size]. 

2. Fixed a problem in macOS14.1.1 where curves and letters on the design were 

corrupted. 

 
 
Version 1.2.61 Release date: October 17, 2023  

⚫ Fixed Bug 

1. Confirmed the operation on macOS14. 

2. Added a function that the cut condition in Remote Panel Utility can be uploaded to a 

main unit via a USB memory stick. 

3. Changed a setting that the location of the barcode on a roll can adjust.  

4. Changed a setting for the cross-cutting function so that it can make a sheet from roll 

on FC9000.  

5. Changed a setting so that the size of the document will be shown on a display when 

selecting “Relative to Media” on the Tiling tab. 

6. Fixed an issue that the scan error with the barcode on a roll occurs in a specific 

situation. 

7. Fixed an issue that “Show guides” and “Snap Guides” were always activated.  

8. Fixed an issue that the software crashed without entering letters in the Memo tool. 

9. Fixed an issue that the registration marks menu shows the position of the print margin 

upside down. 

10. Deleted the unknown items shown in the print preview 

11. Changed the minimum amount of the width and height of the object from “0.25mm" to 

"0.1mm". 

12. Fixed an issue that the Copy tab grays out after removing the barcode for a roll. 

 
Version 1.1.21 Release date: August 23, 2023 

⚫ Fixed Bag 



1. Fixed an issue that the cutting result which was placed out of registration marks was 

shifted when using the function “Convert rectangle”.  

2. Fixed an issue where cutlines were not centered in the preview even when “Center” 

was specified under “Alignment” in the General tab. 

 
Version 1.1.17 Release date: August 9, 2023 

⚫ Fixed Bag 

1. Fixed an issue in a specific font that was not displayed on the design screen. 

2. Fixed an issue that unnecessary lines were displayed when opening PDF files.  

3. Fixed an issue that the “Save as” screen would open even if “Save” was specified.  

4. Added a ruler and a scrollbar in the preview. 

5. Fixed an issue that the one-point compensation function was not applied on the FC9000 

series and CE7000 series.  

6. Fixed an issue that added cut condition was hidden when the dropdown was opened. 

 

 
Version 1.0.273 Release date: June 30, 2023 

⚫ First release 

 

End 

 


